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BAB III 

METODE PENELITIAN 

 

A. Jenis dan Pendekatan Penelitian 

1. Jenis Penelitian 

Jenis yang digunakan pada penelitian ini adalah quasi eksperimen karena 

data yang di analisis berupa suatu pengaruh perlakuan terhadap peserta didik.  

Penelitian quasi-eksperimental digunakan untuk menilai pengaruh perlakuan 

terhadap kelompok eksperimen dibandingkan dengan kelompok kontrol, tanpa acak 

(randomization). Dalam penelitian ini, tujuannya adalah untuk melihat perubahan 

pada peserta didik setelah diberi perlakuan tertentu, seperti intervensi pembelajaran 

atau metode instruksional. Fungsi dari jenis penelitian ini adalah untuk 

mengidentifikasi hubungan sebab-akibat, meskipun tidak memungkinkan untuk 

mengendalikan semua variabel luar seperti pada eksperimen acak (Creswell, 2014). 

 

2. Pendekatan Penelitian 

Pendekatan penelitian yang dilakukan adalah pendekatan kuantitatif karena 

untuk mengidentifikasi pengaruh model pembelajaran APBL yang membutuhkan 

kemampuan kognitif. 

 

B. Desain Penelitian 

Desain penelitian yang akan peneliti gunakan adalah Nonequivalent Control 

Group Design (Sugiyono, 2019;79). Nonequivalent Control Group Design adalah 

sebuah desain penelitian yang didalamnya terdapat dua kelompok, yaitu kelas 
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eksperimen dan kelas kontrol. Desain penelitian ini dapat dilihat pada tabel berikut 

ini.  

 

Tabel 3. 1 Desain Penelitian 

Kelas Pretest Perlakuan Posttest 

Kelas Eksperimen O1 X1 O2 

Kelas Kontrol O3 - O4 

                                                                (Sugiyono, 2019:79) 

 

Keterangan:  

X1 = Kelas dengan pembelajaran model APBL berbasis Green School 

-         = Kelas dengan pembelajaran model konvensional  

O1 = Pretest untuk kelas Eksperimen 

O2    = Posttest untuk kelas Eksperimen 

O3 = Pretest untuk kelas Kontrol 

O4 = Posttest untuk kelas Kontrol 

 

C. Lokasi dan Jadwal Penelitian 

1. Lokasi Penelitian  

Penelitian ini dilaksanakan di SMAN 1 Daha Utara yang terletak di Jl. K.H 

Abdullah, Desa Baruh Kembang, Kecamatan Daha Utara, Kabupaten Hulu Sungai 

Selatan, Provinsi Kalimantan Selatan. Pemilihan sekolah ini sebagai tempat 

penelitian karena adanya permasalahan yang ditemukan oleh peneliti terkait 

kegiatan pembelajaran yang dilakukan di SMAN 1 Daha Utara terkhusus pada 

pembelajaran kimia kelas XI F yaitu kurang aktifnya peserta didik dalam 

pembelajaran, yang mana pembelajaran ini masih berpusat pada guru, proses 
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pembelajaran yang selalu dalam kelas membuat peserta didik bosan, kesulitan pada 

materi kimia, terbatasnya media pembelajaran yang dipakai dalam proses 

pembelajaran, selain itu peserta didik belum pernah diberikan LKPD dengan model 

APBL sebagai media pembelajaran serta dari pihak sekolah baik itu kepala sekolah 

maupun guru kimia yang bersangkutan memperbolehkan peneliti untuk melakukan 

penelitian di SMAN 1 Daha Utara. 

 

2. Jadwal Penelitian  

Penelitian ini dilaksanakan pada kelas XI F2, XI F4 dan XII F6 dari tanggal 

18 September 2024 – 17 Oktober 2024 setiap hari senin, selasa dan rabu. Berikut 

tabel mengenai informasi kegiatan selama penelitian berlangsung. 

 

Tabel 3. 2 Jadwal Kegiatan Penelitian 

Kelas Hari  Jam Pelajaran Kegiatan  

XII F6 Rabu 13:00  - 14:30 Uji Validitas 

XI F4 Senin 10:00 – 11:30 Pretest 

XI F2 Selasa 11:30 – 14:30 Pretest 

 

D. Populasi dan Sampel 

1. Populasi 

  Populasi adalah keseluruhan subjek yang diamati. Populasi dalam 

penelitian ini adalah seluruh peserta didik Kelas XI SMA Negeri 1 Daha Utara ada 

6 kelas yaitu Kelas XI F1, F2, F3, F4, F5 dan Kelas XI F6.   

 

Tabel 3. 3 Populasi Kelas XI 

No Kelas Jumlah Peserta Didik 

1 XI F 1 32 

2 XI F 2 32 

3 XI F 3 30 

4 XI F 4 33 
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No Kelas Jumlah Peserta Didik 

5 XI F 5 31 

6 XI F 6 32 

 

 

 

2. Sampel 

Sampel dalam penelitian ini menjadi bagian penting dalam pengumpulan 

data (Sugiono, 2016). Purposive sampling dipakai untuk teknik pengambilan 

sampel (Priyono, 2016). Teknik pengambilan ini digunakan karena penentuan 

sampel dilakukan dengan pertimbangan tertentu (Arikonto, 2013). Teknik 

pengambilan sampel ini didasarkan atas rekomendasi dari guru kimia dan wakasek 

bidang kurikulum di SMA Negeri 1 Daha Utara, yang mempertimbangkan aspek-

aspek akademis dan karakteristik kelas. Sampel penelitian terdiri dari dua kelas, 

yaitu Kelas XI F2 sebagai kelas kontrol dan Kelas XI F4 sebagai kelas eksperimen.   

 

Tabel 3. 4 Data Ulangan Harian Kelas XI F  

No  Kelas  Nilai Rata-rata  

1 XI F 1 81,85 

2 XI F 2 85 

3 XI F 4 69,48 

 

 Berdasarkan pada hasil nilai rata-rata ulangan harian peserta didik yang 

ditunjukkan pada tabel 3.3. Kelas XI F2 memiliki nilai rata-rata tertinggi, yaitu 85, 

yang menunjukkan hasil belajar yang stabil. Oleh karena itu, kelas XI F2 dipilih 

sebagai kelas kontrol karena dapat dijadikan acuan atau pembanding dalam 

penelitian ini. Di sisi lain, kelas XI F4 memiliki nilai rata-rata terendah, yaitu 69,48. 

Kelas ini dipilih sebagai kelas eksperimen untuk menguji pengaruh penerapan 

metode pembelajaran APBL berbasis green school terhadap peningkatan 
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kemampuan kognitif peserta didik pada materi larutan penyangga. Kondisi awal 

kelas XI F4 yang kurang optimal memberikan peluang untuk mengukur pengaruh, 

perlakuan yang diberikan dalam meningkatkan kemampuan kognitif peserta didik. 

Sementara itu, kelas XI F1 memiliki nilai rata-rata 81,85, yang berada di tengah 

antara kelas XI F2 dan XI F4. Meskipun hasil belajar kelas ini cukup baik, kelas XI 

F1 tidak dipilih dalam penelitian untuk menjaga fokus pada perbandingan antara 

kelas dengan hasil belajar tertinggi (XI F2) dan terendah (XI F4). Pemilihan kelas 

XI F2 dan XI F4 sebagai objek penelitian.  

 

E. Data dan Sumber Data 

1. Data  

Data dalam penelitian ini, terdapat dua jenis data yang diperlukan, yaitu data 

primer dan data sekunder. 

a. Data Primer  

Data primer merupakan informasi yang diperoleh secara langsung dari 

sumber utama. Dalam penelitian ini, data primer yang dikumpulkan berfokus pada 

kemampuan kognitif peserta didik berbasis Green school. Data ini diperoleh 

melalui pelaksanaan mengerjakan soal essay dengan indikator kemampuan kognitif 

yang difokuskan pada materi larutan penyangga. 

 

b. Data Sekunder  

Merupakan data tidak langsung yang memberikan data kepada pengumpul 

data. Dalam hal ini data yang didapatkan melalui dokumen dimana semua catatan 
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atau arsip tertulis memuat data informasi yang mendukung penelitian diantaranya 

lembar kerja peserta didik, absen, artikel relevan, buku dan lain-lain. 

2. Sumber Data 

Penelitian ini mengumpulkan data dari berbagai sumber yang meliputi: 

 

a. Responden 

Sampel penelitian terdiri dari dua kelas, yaitu Kelas XI F2 sebagai kelas 

kontrol dan Kelas XI F4 sebagai kelas eksperimen. Peserta didik kelas XI F2 dan 

XI F4 SMA Negeri 1 Daha Utara yang telah dipilih sebagai sampel penelitian. 

 

b. Informan 

Informan yaitu guru mata pelajaran kimia kelas XI, Wakasek kurikulum dan 

staf tata usaha di SMA Negeri 1 Daha Utara. Mereka memberikan informasi yang 

relevan terkait dengan data yang diperoleh dari responden. Hal ini dapat dilakukan 

melalui wawancara atau diskusi. 

 

c. Dokumen 

Dokumen yang mencakup semua catatan atau arsip tertulis memuat data 

informasi yang mendukung penelitian. 

 

 

 

 

 

 

 

Tabel 3. 5 Matriks Data Primer dan Sekunder 
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No Data Sumber Data 

Teknik 

Pengumpulan 

Data 

  1 Data primer  

a. Data dari hasil pretest terkait 

kemampuan awal peserta didik dalam 

memahami materi larutan penyangga 

b. Data dari hasil posttest terkait 

kemampuan kognitif peserta didik 

dalam memahami materi larutan 

penyangga  

Responden 

Tes 

 

c. Observasi keterlaksanaan 

pembelajaran menggunakan LKPD 

dengan model APBL pada materi 

larutan penyangga 

Observasi 

  2 Data sekunder  

a. Jadwal pembelajaran kimia kelas XI F 

SMAN 1 Daha Utara 

b. Data peserta didik yang dijadikan 

sampel dalam penelitian  

Informan dan 

dokumentasi 
Dokumentasi 

 

F. Teknik Pengumpulan Data 

1. Tes 

Dalam penelitian ini, tes digunakan sebagai metode pengumpulan data 

melalui soal essay dengan 5 soal yang telah divalidasi dengan indikator kemampuan 

kognitif yang akan mengukur kemampuan peserta didik. 

Tes yang dipakai dalam penelitian ini berupa tes objektif untuk mengukur 

kemampuan kognitif peserta didik pada materi larutan penyangga. Tes ini dilakukan 

sebanyak dua kali yakni tes awal (pretest) dilakukan sebelum penerapan 

pembelajaran menggunakan LKPD dengan model APBL materi larutan penyangga 

diterapkan. Sampel penelitian terdiri dari dua kelas, yaitu Kelas XI F2 sebagai kelas 

kontrol dan Kelas XI F4 sebagai kelas eksperimen. Tes akhir (posttest) diberikan 

kepada peserta didik sesudah pembelajaran dengan model APBL materi larutan 

penyangga. Tes yang dilakukan kepada peserta didik memiliki bentuk yang sama 
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baik itu ketika tes awal maupun tes akhir. Data tes inilah yang nantinya akan 

dijadikan acuan untuk menarik kesimpulan pada akhir penelitian.  

 

2. Dokumentasi 

Dokumentasi diabadikan dalam bentuk-bentuk gambar atau video dengan 

menggunakan handphone dan kamera. 

 

3. Wawancara  

Menggunakan pedoman wawancara langsung dengan guru kimia di SMA 

Negeri 1 Daha Utara. Guru menjelaskan bahwa pada pembelajaran kimia kelas XI 

peserta didik cenderung kesulitan pada materi hidrolisis, larutan penyangga dan 

koloid, dikarenakan materi asam basa, hidrolisis dan larutan penyangga memiliki 

keterkaitan sehingga peserta didik mengalami kesulitan mengingat komponen asam 

basa kuat, asam basa lemah dan garam. Mengambil materi larutan penyangga di 

sekolah membantu siswa memahami konsep kimia yang mendasar, relevansi 

aplikasinya di kehidupan sehari-hari, biologi, kesehatan, industri, dan teknologi. 

Selain itu, materi ini juga mempersiapkan siswa dengan keterampilan pemecahan 

masalah dan pengetahuan yang diperlukan untuk pendidikan lanjutan atau karier. 

 

4. Observasi 

Observasi merupakan suatu cara atau teknik pengumpulan data dengan 

mengamati secara langsung kegiatan yang sedang dilakukan. Observasi pada 

penelitian ini dilakukan untuk memperoleh data proses selama kegiatan belajar 

mengajar berlangsung serta untuk mengetahui keterlaksanaan penggunaan LKPD 

dengan model APBL materi larutan penyangga.  
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G. Instrumen Penelitian 

Instrumen penelitian adalah alat bantu dalam suatu penelitian yang 

digunakan untuk peneliti dalam mengumpulkan data yang diperlukan. Instrumen 

yang digunakan dalam penelitian ini ada dua yakni instrumen tes dan instrumen non 

tes. 

 

1. Instrumen Tes  

Instrumen tes yang digunakan dalam penelitian ini adalah butir soal. Butir 

soal digunakan dalam tes tertulis untuk mengetahui kemampuan asli, aktual dan 

kemampuan potensial peserta didik. Soal-soal tersebut adalah soal essay yang 

digunakan dalam melaksanakan sebuah tes yang diberikan adalah soal yang 

berdasarkan indikator kemampuan kognitif soal divalidasi oleh validator ahli 

materi. 

Penyusunan instrumen tes dilakukan dengan memperhatikan beberapa hal, 

yaitu: 

a. Instrumen tes mengacu pada kurikulum merdeka.  

b. Instrumen tes mengacu pada indikator pencapaian dari LKPD dengan model 

APBL. 

c. Instrumen tes berpedoman pada kriteria alat ukur yang baik, yakni 

memenuhi uji validitas dan reliabilitas. 

 

 

 



 
 
 

39 

 

 
 

2. Instrumen Non Tes 

Instrumen non tes yang digunakan dalam penelitian ini adalah lembar 

observasi. Lembar observasi digunakan untuk mengamati aktivitas peserta didik 

ketika proses pembelajaran berlangsung. 

 

H. Teknik Analisis Data 

1. Uji Prasyarat 

a. Uji Normalitas 

Untuk menguji normalitas, digunakan uji Shapiro-Wilk dengan 

menggunakan aplikasi SPSS Statistics versi 25. Berikut adalah langkah-langkah 

dalam pengujian normalitas ini: 

Data → analyze → descriptive statistics → explore → dependent list dan 

factor list → Button plots → continue→ continue → ok 

Pengambilan keputusan: 

P ≥ 0,05 = data terdistribusi normal 

P < 0,05 = data tidak terdistribusi normal 

 

b. Uji Homogenitas 

Pengujian ini dilaksanakan dengan menggunakan perangkat lunak SPSS 

versi 25, dan berikut ini adalah prosedur yang dilakukan dalam tahap pengujian ini: 

Data Frekuensi → Analyze → Compare Means → One-Way → ANOVA→ 

Dependent List → Factor→ Option→ Homogeneity Of Variance Test → Continue 

→ Ok 

Pembacaan keputusan: 
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P ≥ 0,05 = Ha ditolak (data homogen) 

P < 0,05 = Ha diterima (data tidak homogen) 

 

c. Uji Hipotesis dengan Uji Independent Sample t-test 

Metode Independent Sample t-test, yang bertujuan untuk menguji 

signifikansi perbedaan rata-rata nilai antara dua kelompok sampel yang tidak  

berkorelasi. Berikut ini adalah langkah-langkah yang dilakukan dalam tahap 

pengujian tersebut: 

Analyze → Compare Mean → Independent Sample t-test → Isi Test 

Variable → Isi Grouping Variables →  ok 

Dalam proses pengambilan keputusan berdasarkan kriteria signifikansi, 

digunakan suatu nilai α. Apabila nilai α (alpha) memiliki nilai ≥ 0,05, maka 

hipotesis nol (H0) akan diterima dan hipotesis alternatif (Ha) akan ditolak. Namun, 

jika nilai α memiliki nilai < 0,05, maka hipotesis nol (H0) akan ditolak dan hipotesis 

alternatif (Ha) akan diterima. 

 

I. Teknik Validitas dan Keabsahan Data 

Teknik validitas dan aspek keabsahan data yang digunakan sebelum 

penelitian untuk mengolah data. Pada teknik validitas dan keabsahan data dilakukan 

uji validitas dan reliabilitas untuk mengetahui valid dan reliabilitasnya instrumen 

yang digunakan dalam penelitian berlangsung. Uji ini menjadi syarat terlaksananya 

pengolahan data langsung dilapangan.  
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1. Uji Validitas 

Uji validitas merupakan uji yang memberikan keabsahan atau kevalidan 

sebuah instrumen. Tujuan uji validitas ini menunjukkan seberapa bagus alat ukur 

mampu mengukur apa yang hendak diukur. Uji validitas terdiri dari uji validitas 

kepada tim validator dan uji validitas soal. 

Teknik yang digunakan untuk mengukur validitas soal adalah teknik 

korelasi product moment dengan memakai angka kasar (raw score). Teknik ini 

digunakan untuk menilai kekuatan hubungan antara dua variabel dalam penelitian. 

Berikut adalah tabel kriteria validitas berdasarkan nilai "r" Product Moment 

menurut Arikunto (2020). 

 

Tabel 3. 6 Tabel Kriteria Validitas LKPD 
Nilai  Kriteria 

0, 00 – 0,199 Tidak sesuai 

0,20 – 0, 399 Kurang sesuai 

0,40 – 0, 599 Cukup sesuai 

0,60 – 0,799 Sesuai  

0,80 – 1,00 Sangat sesuai  

(Sugiyono, 2007) 

 
 

2. Uji Validitas Soal 

Untuk menguji validitas soal, digunakan perangkat lunak SPSS versi 25 for 

Windows sebagai alat bantu. Dalam analisis ini, instrumen dianggap valid jika nilai 

r-hitung melebihi nilai r-tabel, sementara jika nilai r-hitung lebih rendah dari nilai 

r-tabel, maka instrumen dianggap tidak valid. Berikut adalah langkah- langkah uji 

validitas menggunakan SPSS: 
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Data → Analyze → Correlate → Bivariate → Masukkan Variables → 

Correlation → Coefficients Pearson → Ok. 

Dengan mengikuti langkah-langkah tersebut, uji validitas soal dapat 

dilakukan dengan melihat tampilan SPSS yang dilihat untuk mendapatkan nilai r-

hitung yang akan dibandingkan dengan nilai r-tabel. 

 

3. Uji Reliabilitas 

Reliabilitas artinya dapat dipercaya, jadi dapat diandalkan. Kriteria suatu 

instrumen penelitian dikatakan reliabel dengan menggunakan teknik ini bila 

koefisien r11 > 0,6. Menurut Riduwan (2016:9) instrumen dikatakan reliabel 

dengan melihat kriteria nilai reliabilitas sebagai berikut. 

 

Tabel 3. 7 Kriteria Penafsiran Indeks Reliabilitas 
Nilai r11 Kriteria 

0,81– 1,00 Sangat Tinggi 

0,61 – 0,80 Tinggi 

0,41– 0,60 Sedang 

0,21– 0,40 Rendah 

0,00- 0,20 Sangat Rendah 

(Arikunto, 2020:89) 

a. Bagi Peneliti  

 

4. Uji Validitas 

Pengujian validasi digunakan untuk mengukur tingkat valid atau sah nya 

pertanyaan. Pertanyaan dianggap valid apabila pertanyaan tersebut dapat 

mengungkapkan sesuatu yang diukur. Uji validitas soal pada penelitian ini diolah 

menggunakan SPSS Version 25. Uji validitas soal pada penelitian digunakan untuk 

mengukur sah atau tidak suatu pertanyaan dengan skor total pada tingkat 
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signifikansi 5% dan jumlah sampel sebanyak 32 responden di kelas XII F6. Untuk 

pengujian validitasnya, maka peneliti membandingkan pearson correlation setiap 

butir soal dengan r tabel. Jika rhitung > rtabel maka item pernyataan tersebut 

dinyatakan valid. Hasil uji validitas soal dapat disajikan pada Tabel 3.9 dengan n= 

32, maka didapatkan df sebesar 32-2 = 30 dan α = 5 % maka nilai r tabel sebesar 

0.3494. 

 Keputusan:  

𝑟𝑖 ≥ r tabel : maka item pernyataan valid  

𝑟𝑖 < r tabel : maka item pernyataan tidak valid  

"Jika rhitung > rtabel, maka item pernyataan dinyatakan valid. Sebaliknya, 

jika rhitung < rtabel item pernyataan dinyatakan tidak valid. Berdasarkan hasil uji 

validitas soal dengan n=32n – 2 = 30, diperoleh derajat kebebasan (df) sebesar 

n−2=30, dan pada taraf signifikansi (α) sebesar 5%, nilai r tabel adalah 0,3494." 

(Sugiyono, 2013). 

 

5. Uji Reliabilitas  

Uji reliabilitas berguna untuk menetapkan apakah instrumen penelitian yang 

digunakan, dalam hal ini dapat digunakan lebih dari satu kali atau paling tidak oleh 

responden yang sama. Perhitungan reliabilitas adalah perhitungan terhadap 

konsistensi data kuesioner dengan menggunakan rumus Alpha Cronbach. 

Penggunaan rumus ini disesuaikan dengan teknik skoring yang dilakukan pada 

setiap item dalam instrumen. Nilai correlated item-total correlation dalam suatu 

indikator agar dinyatakan handal adalah minimal 0.60. Berikut merupakan hasil 

dari uji reliabilitas dari masing-masing variabel. 
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6. Uji Validitas Kepada Tim Validator  

Sebelum menggunakan instrumen kepada peserta didik, validasi instrumen 

sangat penting dilakukan untuk mengevaluasi kevalidan instrumen tersebut. Dalam 

penelitian ini, validasi dilakukan oleh tiga validator yang terdiri dari dua akademisi 

di Program Studi Tadris Kimia, Fakultas Tarbiyah dan Keguruan, UIN Antasari 

Banjarmasin yaitu bapak Alvian Ikhsanul Fatya, S.Pd., M.Si., dan ibu Ratna Kartika 

Irawati, S.Pd., M.Pd., dan satu guru pengampu mata pelajaran kimia di SMAN 1 

Daha Utara yaitu ibu Dian Erliyani, S.Pd. Hasil validitas yang didapatkan dari tim 

ahli validator dapat diamati pada tabel. 

 

Tabel 3. 8 Kriteria Validitas  
No Skor Kriteria Validitas 

 1 81% - 100% Sangat valid 

2 61% - 80% Valid 

3 41% - 60% Cukup valid 

4 21% - 40% Tidak valid 

5 0% - 20% Sangat tidak valid 

Sumber. Fau, Bago & Telaumbanua (2024) 

 

 


